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Category Notes
Category Notes
Each module provides a notes feature that allows you to record and track text-based notes and
attach a variety of document types to the notes. You can attach Microsoft Word documents,
Microsoft Excel spreadsheets, Adobe Acrobat PDFs, and virtually any other type of nonexecutable file.
Each primary data entry screen and sub screen in each module has a Category Notes button.
When the Category Notes button is selected, the notes screen is opened and only notes
assigned to that particular category can be viewed. For example, to view notes within the
Personnel Management module that have been assigned to the Personal category, the
Category Notes button would need to be selected from the primary Personal screen or any of
the Personal sub screens.
The Notes screen includes the Note Details grid and the following buttons: Attach, Delete,
Show and Scan.
Note: The Category Notes button can be turned off for a user by clearing the Notes check box
in User Setup.

Note Details Grid
The individual notes are displayed in the Note Details grid. This grid contains the columns
described below.

User
Indicates the User ID of the People-Trak user who created the note. This field is
automatically assigned and is for display only.

Note Date
Indicates the date of the note. If you do not enter a note date, the date will be set to today’s
date.

Note Text
The text of the note. The first line of the note is initially displayed. If you wish to display or
enter additional lines, use the multi-line editor popup button to display the entire text of the
note.

Type
Indicates the type of file attached to this note, if any. If a note has an attachment, you can
activate the attachment and start the product used to create or edit the attachment by clicking
the Show Attachment button. For example, if you have attached a Microsoft Word document,
the Type will be DOC or DOCX. You can then click the Show Attachment button, which will
start Word and load the attached document.

Category Notes

Attachment Buttons
There are four attachment buttons available on the right hand side of the Notes screen. The
Attach button is available once a note has been entered on the current row, and allows you to
select the file to attach to the note. The Delete button is available when on a note that has an
attachment, and allows you to delete the attached file. The Show button is available when on
a note that has an attachment, and allows you to show the attachment. The Scan button is
available once a note has been entered on the current row, and allows you to utilize your own
scanner to attach a scanned image.

All Categories Button
You can display the notes for all categories by selecting the All Notes button located on the
right hand side of the Notes screen. All fields on the All Notes screen are display only and
cannot be modified. Notes can be sorted by any column using standard grid conventions.
Simply click on the grid header for the column on which you wish to sort. The note rows will
then be sorted in that order. The Show button is available when on a note that has an
attachment, and allows you to show the attachment.

Working With Notes
Viewing the Entire Text of the Note
To facilitate navigation and rapid viewing, notes are initially presented as single lines in the
notes grid. You can move through the rows on the grid using standard grid navigation
conventions. If you wish to view the entire text of any note, simply position the cursor to the
desired row and click on the multi-line editor popup button. The entire text of the note is
displayed in the multi-line editor and may be edited.
If you just viewed the note or made updates you want to save, click the OK button to return to
the Notes screen. If you made updates to the note but do not want to save the changes, click
Cancel.

Showing Notes for other Categories
When selecting the Category Notes button on primary and sub screens, the notes for the
category associated with the primary screen are displayed. You can display and edit the notes
for other categories by selecting the appropriate primary or sub screen and selecting the
Category Notes button located on that screen.

Deleting Notes
Notes can be deleted using the Delete Row option, which is available on the Edit menu and
on the Tool Bar. When the Delete Row option is used, the entire note including any
attachment is deleted.

Sorting Notes
When notes are first displayed, the notes are displayed in descending order by note date.
Notes can be sorted by other columns using standard grid conventions. Simply click on the
grid header for the column on which you wish to sort. The note rows will then be sorted in
that order. You can also order the notes in any random order using the Row Up and Row
Down buttons on the Tool Bar. Like other grids, note rows are stored back into the database
in the order in which you last sorted them
In addition, you will notice that when the sort order is changed in one category, the sort order
persists for the rest of the categories. The primary reason for sorting notes is for viewing and
printing purposes.
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Category Notes

Printing Notes
You can print the list of currently displayed notes at any time using the Print button on the
Tool Bar. If you wish to print a particular list of notes in a particular order, select the
appropriate category and sort the list the way you want. The note report will reflect the list as
you see it.
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Working with Attachments
People-Trak provides a unique feature that enables you to attach files to your note records.
These files can be retrieved and viewed at any later time.

Attachments do not Use Linked Files
The files that you attach to People-Trak are not stored as linked files. With linked files, you
simply store the name and path to the original file. If the file is moved, deleted, modified or
lost, the link is no longer valid and the attachment is lost. In addition, linked files are not
secure. A linked file that is located by any user can be opened and read at any time. Linked
files are not a satisfactory method of storing attachments.

How Attachments are Stored
With People-Trak, there is one attachment file for each attachment and that attachment file is
stored in the database. The attachment is a copy of the original file, so you are not dependent
on the original file. If the original file is lost or deleted, you will always have the copy
associated with the applicable note record. Should you wish to export the attachment out of
the attachments file, you can do so using the “Save As” feature of the product.

Attaching a File
The process for attaching files is the same process regardless of whether you are attaching
Word documents, Excel spreadsheets, image files, or any other type of file.
If the note to which you wish to attach a file does not yet exist, add the note. If the note does
exist, select the desired note row.
You are allowed one attachment per note. An attachment can only be added if there is no
existing attachment for that note.
When a file has been selected, internal processing for the attachment is performed. A copy of
the file is made, and the file is compressed and moved into the attachment file for the current
record. The type of file is then added to the Type column of the grid.

Activating Existing Attachments
When you have attached a file to a note, the Type column was updated to indicate the type of
file attached to that note. You can activate the attachment and view it within the applicable
product by clicking the Show Attachment button. The applicable product (Word, Excel, an
image editor, Adobe Acrobat, etc.) will be loaded and the attachment will be displayed.
In order to activate an attachment and use the product with which it is associated, you must
have that product or a related product installed and functional. For example, if one user has
attached a Microsoft Word document and you wish to read that document as an attachment,
you must have Microsoft Word or an equivalent installed and functional on your computer.
The applicable product is determined by the file associations on your computer. If you have
associated Word documents with another tool or product, that product can be used to open the
attachment.

Attachments
If you activate an attachment and modify the document within the associated product, the
attachment will not automatically be put back into People-Trak. This is because the process
that is editing the attachment works completely independently of People-Trak. That product
does not know that you wish to move the modified attachment back into People-Trak. If you
wish to place a modified attachment back into the note record, you need to save the edited
attachment to a file, delete the original attachment, and then attach the new file.

Deleting an Attachment
An existing attachment can be deleted from a note at any time. When an attachment is
deleted, it is removed from People-Trak permanently. If you wish to export an attachment so
that you can use it elsewhere, use the Export feature described in the next section. To delete
an attachment, select the note with the attachment and click the Delete button. The attached
file will be deleted from the database and the Type column for that note row will be cleared.

Exporting an Attachment
Files that have been attached to notes can be exported from the database for use with another
product or for any other purpose. For example, if you have attached employee photographs
and you wish to use them for an employee newsletter or an award, you might wish to export
the image.

Notes and Attachments that Originate from Email
Notes and attachments can be automatically added from the Email feature.
The following fields on the Send Email screen are applicable for attachments.

To
The email address of the record that is to receive notes. When emails are sent in bulk,
multiple email addresses can be listed. The email addresses are used to lookup the unique ID
for the appropriate records so that the note can be added.

Subject
The subject of the email. The entry in this field is added as the first line of the note text in the
formation shown below.
Email Subject: Subject

Template
If a template is being used, this is the name of the template. When the note is created, the
template with appropriate field data merged becomes the text of the note. The template text is
added after the first line that was composed of the email subject. Thus, when the notes are
listed in unexpanded form, you can readily determine which notes were generated by email.

Text
The text of the email becomes the text of the note. The email text is added after the first line
that was composed of the email subject. Thus, when the notes are listed in unexpanded form,
you can readily determine which notes were generated by email.

Attachment 1
If a file is being attached to the email, the same attachment will be added to the note. This
field contains the name of the file that will be attached to the notes.
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Attachment 2
If a file is being attached to the email, the same attachment will be added to the note. This
field contains the name of the file that will be attached to the notes.

Attach Document
If a document is being attached to the email, the same document will be added to the note.
This field contains the name of the document that will be attached to the notes.
Note: If multiple attachments are added to an email, there will be a note added for each
attachment.

Add Email to Notes
A check box that allows you to specify whether or not the email and any applicable
attachment will be added to the notes. Select the check box to add a note to the record
associated with each email address in the To field. Clear the field to not add a note to the
records. This check box is defaulted to selected if the Add Email to Notes check box is
selected for the current module in Module Setup.
Note: If you are in a module whose key record does not have an email address associated
with it, the record cannot have a note attached to it. For example, if you are in the Training
Course module, the key record is the training course, which of course is not a person that can
receive an email. Also, if one of the To recipients does not have a People-Trak record
associated with it, such as in the case of a vendor, then no record exists to have a note
attached to it.

Note Category
If the email is being sent to notes, this field determines the note category to which the note
will be added. It is supported by the list of available categories. A note cannot be added
unless a note category is specified. If the Add Email to Notes check box was defaulted to
selected, this field is also defaulted to the category specified for the current module in
Module Setup.

Notes, Attachments, and Document Management
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Document Management Module
The Document Management module has been added to People-Trak and is included as part of
the Strategic Toolkit option. This module provides you with an enhanced ability to track and
define documents that have been attached via Archived Documents or the e Category Notes
feature. In addition, documents may be created in this module independent from the archive
document or notes features.
Within the Document Management module, you have the ability to search across modules
using one of the appropriate search tag fields.

Document Screen
ID and Name Frame
Document ID

A number or phrase that uniquely identifies the document in the current database. If you try
to add a document with an existing ID, or if you try to change the ID of an existing document
to an existing ID, you will not be allowed to proceed. In addition, the document ID field is
mandatory. A document record cannot be saved unless a document ID has been specified. If
you have activated the Auto-numbering feature, the next document number is automatically
assigned when you first create a new document record. The format for an auto-number ID is
defined for the Document Management module using the Module Setup program.

Document Name

The name of the document. This field is used to identify the document.
Note: If the document originated from an archived document, this field will be display only
and will reflect the archived document name.

Module Name

The module in which the document was created. This field is display only and cannot be
modified.

Search Tag 1

A user defined text field used to define search criteria for the document.
Note: If the document originated from a note, this field will be display only and will reflect
the Search Tag 1 criterion that was assigned to the note when it was created. If the document
originated from an archived document, this field will reflect the Search Tag 1 criterion that
was assigned to the archived document when it was created. This field may be modified if
needed.

Search Tag 2

A user defined text field used to define search criteria for the document.
Note: If the document originated from a note, this field will be display only and will reflect
the Search Tag 2 criterion that was assigned to the note when it was created. If the document
originated from an archived document, this field will reflect the Search Tag 2 criterion that
was assigned to the archived document when it was created. This field may be modified if
needed.

Search Tag 3

A user defined text field used to define search criteria for the document.

Document Management Module
Search Tag 4

A user defined text field used to define search criteria for the document.

Document Frame
Document
Category

The category into which the document is to be placed. This category can be used to secure
documents. A table that contains all of the existing organizer categories for the current
module supports this field. You can only select a valid entry from the table.
Note: If the document originated from a note or archived document, this field will be display
only and will reflect the category that was assigned to the note or archived document when it
was created.

Document
Creator

Indicates the User ID of the People-Trak user who created the note. This field is
automatically assigned and is for display only.

Document Date

Indicates the date that the document was created. This field is automatically assigned and is
for display only.

Document Text

The text of the note. If you wish to display or enter additional lines, use the multi-line editor
popup button to display the entire text of the note.
Note: This field will reflect the note text or the archived document description if it has
originated from either of those sources.

Attachment Type

Indicates the type of file attached to this document, if any. If a document has an attachment,
you can activate the attachment and start the product used to create or edit the attachment by
clicking the Show Attachment button. For example, if you have attached a Microsoft Word
document, the Type will be DOC or DOCX. You can then click the Show Attachment
button, which will start Word and load the attached document.

Attachment Buttons
There are six attachment buttons available on the right hand side of the Documents screen.
The Attach button allows you to select the file to attach to the document. The Delete button is
available when a document has an attachment and allows you to delete the attached file. The
Show button is available when a document has an attachment, and allows you to show the
attachment. The Scan button allows you to utilize your own scanner to attach a scanned
image.

Detail Button
The Details button displays the Detail screen for the attachment. The screen includes the
following fields.
Revisit Date

The date the attachment is to be revisited. This field is supported by the Select Date popup.

Revisit Text

The text associated with the Revisit Date. A multi-line editor popup is available for this field.

Retention Months The number of months the document is to be retained for. The Expiration Date field is
automatically derived from the date that has been entered in this field.
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Document Management Module
Expiration Date

The date on which the attachment expires. This field is supported by the Select Date popup.
The Expiration Date field is automatically derived from the date that has been entered into
the Retention Months field, but may still be modified.

Expiration Text

The text associated with the Expiration Date. A multi-line editor popup is available for this
field.

History Button
The History screen provides access history for the attachment and includes the following
fields.
Action Date

The date the action occurred.

Action Time

The time the action occurred.

Action Type

The comment showing the action that occurred. The comment can be one of the following:
Attached
Deleted
Opened

Accessed By

A document was attached.
An attachment was deleted.
An attachment was viewed.

The User ID of the user that performed the action.

Notes, Attachments, and Document Management
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Document Management Features in Archive and
Category Notes
Within Archived Documents and Category Notes, the implementation of Document
Management, provides additional fields that are captured and fields that need to be defined
for use within triggers and search criteria.

Output to Archive
Search and Retention
The Search and Retention frame on the Output to Archive screen includes the following
fields.
Search Tag 1

A user defined text field used to define search criteria for the document.

Search Tag 2

A user defined text field used to define search criteria for the document.

Revisit Date

The date the attached document is to be revisited. This field is supported by the Select Date
popup.

Revisit Text

The text associated with the Revisit Date. A multi-line editor popup is available for this field.

Retention Months The number of months the document is to be retained for. The Expiration Date field is
automatically derived from the date that has been entered in this field.
Expiration Date

The date on which the attached document expires. This field is supported by the Select Date
popup. The Expiration Date field is automatically derived from the date that has been entered
into the Retention Months field, but may still be modified.

Expiration Text

The text associated with the Expiration Date. A multi-line editor popup is available for this
field.

Category Notes
Detail Button
The Details button displays the Detail screen for the selected note. The screen includes the
following fields.
Search Tag 1

The source ID, which is the ID of the record that the note was created in. For example, if a
note was made in Donald’s employee record, the Search Tag 1 would be his Employee ID
which is 1006. This field is display only and cannot be modified.

Search Tag 2

The description associated with the source ID of the record that the note was created in. For
example, when a note is created in Donald Stern’s record, the Search Tag 2 will default to the

Document Management Features in Archive and Category Notes
description, which is his name: Stern, Donald E. This field is display only and cannot be
modified.
Revisit Date

The date the attachment is to be revisited. This field is supported by the Select Date popup.

Revisit Text

The text associated with the Revisit Date. A multi-line editor popup is available for this field.

Retention Months The number of months the attachment is to be retained for. The Expiration Date field is
automatically derived from the date that has been entered in this field.
Expiration Date

The date on which the attachment expires. This field is supported by the Select Date popup.
The Expiration Date field is automatically derived from the date that has been entered into
the Retention Months field, but may still be modified.

Expiration Text

The text associated with the Expiration Date. A multi-line editor popup is available for this
field.

History Button
The History button displays the History screen for the selected note. The screen provides
access history for the note attachment and includes the following fields.
Access Date

The date the action occurred.

Access Time

The time the action occurred.

Access Type

The comment showing the action that occurred. The comment can be one of the following:
Attached
Deleted
Opened

Access By
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A document was attached.
An attachment was deleted.
An attachment was viewed.

The User ID of the user that performed the action.
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This lesson covers how to use the notes and attachments feature provided with People-Trak.

Tutorials
Adding and Deleting Notes: shows how to add and delete notes.
Working with Categories: demonstrates how the note categories are used to organize notes
based on the primary data entry screens.
Attaching a File: shows how to create and attach a file to a note.
Opening an Attachment: demonstrates how to open an attachment file using the software
product that was used to create the attachment.
Deleting an Attachment: shows how to delete an attachment that was added to a note.

Lesson 1

Tutorial 1.1 – Adding and Deleting Notes
The Notes screen is essentially a grid with some additional enhancements to support
attachments and a large multi-line text box. In this lesson, we’ll see how these enhancements
work.
1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop
(or as instructed).
The Select Product Option screen is displayed.
2. The Position Control and Attendance options should be the only options that are
toggled on. If they are not, select the Training button.
3. Click OK.
The Login screen is displayed.
4. In the User ID field, enter DEMO.
5. In the Password field, enter DEMO.
The Organizer desktop is displayed with the Personnel Management module selected
6. Open Donald Stern’s record.
The Personal screen is displayed. Notes within the Personal category are accessed by
clicking the Category Notes button, which is the third button on the Category Bar. The
Category Notes screen is available from virtually all of the primary data entry screens and
sub screens in People-Trak.
Note: The Category Notes button can be turned off for a user by clearing the Notes check
box in Security Setup.
7. Select a few of the primary screens and find the Category Notes button.
8. Return to the Personal screen and click the Emergency button.
The Emergency Contacts screen is displayed.
9. Find the Category Notes button. It is available here and on other sub screens as well.
10. Close the Emergency Contacts screen to return to the Personal screen. Click the
Category Notes button.
The Notes for Personal Category screen is displayed with the notes in descending order
by note date. As mentioned, the primary component on the screen is a grid, but this grid
has some special features. The record for Donald Stern already has notes defined for the
Personal category. Typically, you would add a new note by inserting a row at the top of
the grid. For demonstration purposes let’s see what happens when a note is added on the
first blank row.
11. In the first blank row, click in the Note Date column.
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You can enter today’s date manually, click the Date popup button or use the Date Stamp
feature. Let’s use the Date Stamp feature.
12. Select Cancel to close the Select Date popup.
13. On the Edit menu, select Date Stamp.
Today’s date is entered into the Note Date column.
Note: You can also invoke the Date Stamp feature by pressing F4. On a new note, if you
add an attachment or enter the Note Text before entering the Note Date, the Note Date
field automatically populates with today’s date.
14. Press ENTER to leave the Note Date column.
The User column is automatically populated with the current user ID DEMO. The User is
automatically assigned and is for display only.
15. In the Note Text column, enter the text This is my first note and press ENTER. The
note is complete. If you want to enter a note for today’s date, there is an even faster way
to enter a note. Let’s see how this works.
16. In the next blank row, click in the Note Text column and enter the text This is my
second note and press ENTER.
The User and Note Date fields are defaulted for you and the note is done!
Now, let’s see how to insert a row rather than just add a row at the bottom of the notes
grid.
17. Click anywhere in the first row of the grid.
18. On the Tool Bar, click the Insert Row button to insert a row.
Note that the User field is completed just as before. Additionally, the Note Date is
automatically populated with today’s date. This time, let’s enter a note longer than the
one line we are shown. We could keep typing and have the note wrap or we could use the
multi-line editor. Let’s try the multi-line editor, which allows you to see all the text you
are entering.
19. In the Note Text column, click the popup button to open the multi-line editor.
A Simple Editor screen is displayed. You can now type away for as long as you like. If
you reach the end of the line, word-wrap will be performed and the cursor will jump to
the next line. If you press ENTER, the current line will be broken and the cursor will
jump to a new line. Try these now.
20. Type a sentence or paragraph that wraps. Then on the second line, press ENTER to start
another new line. Add a few more lines with the ENTER key and make a nice long note.
21. When you are finished with your note, click OK to close the editor.
Only the first line of your note is displayed in the grid. If you wish to review the text of
your note or to add more text, click the popup button to expand the note text area and
view or edit the text.
Notes, Attachments, and Document Management
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The Notes screen has been designed to allow you to rapidly view the first line of each
note relative to the other notes. If you wish to review the note in more detail (if the note
has more detail), you need only click the popup button. In fact, you can actually browse
your notes with the mouse. Try this.
22. Click in the Note Text column of the first row.
23. Open the editor, read the note text, close the editor. Click on the next line.
Open the editor, read the note text, close the editor. Click on the next line.
Open the editor, read the note text, close the editor.
You can use this technique to rapidly browse all notes for any record.
Now that we know how to add notes, let’s see how to delete notes.
24. Click anywhere in the first row of the grid.
25. On the Tool Bar, click the Delete Row button to delete the current note.
26. Use Delete Row to delete the other notes you entered.
27. Close the Notes for Personal Category screen, saving your changes.
28. Continue with the next tutorial.
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Tutorial 1.2 – Working with Categories
When we entered the notes in the last tutorial, the note category was the category of the
screen from which the Category Notes button was clicked. Each primary data entry screen in
People-Trak has a screen category associated with it.
1. In the Screen dropdown, select Status.
1. On the Category Bar, click the Category Notes button.
Unlike the Personal category, there are no Status notes for Donald Stern.
2. Enter a note using the techniques you just learned.
3. Close the Notes for Status Category screen, saving your changes.
Try a few other screens and their Category Notes buttons. Some categories may contain
notes and others may not. If you would like to see the notes within a record, you can do
so by selecting the All Notes button.
4. Select the Personal screen, and select the Category Notes button.
5. Select the All Notes button located to the right of the notes grid.
The All Notes screen is displayed. This screen is mainly used viewing and printing
purposes, so all fields are display only and cannot be modified. You may have also
noticed a Note Category column header listing the categories from which the notes came
from.
In addition, this particular grid shares the standard operating conventions of other grids in
People-Trak. This means that you can sort the grid using any of the column headers. We
can demonstrate this by sorting our notes by category.
Note: Grid sorting can be turned off for a user by clearing the Grid Sorting check box in
Security Setup.
6. Click the Note Category column header.
The grid is now sorted by category in ascending order.
Try selecting the different column headers to sort the notes in other ways.
These same sorting conventions also work within the category note screens. Let’s take a
look at how they work for the Notes for Personal Category.
7. Close the All Notes screen.
8. On the Notes for Personal Category screen, click the Note Date column header.
The grid is now sorted by date in ascending order.
Like other grids, note rows remain sorted in the most recently sorted order.
9. Close the Notes for Personal Category screen and open it back up again.
The grid is still sorted by ascending note date within that category.
Notes, Attachments, and Document Management
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Like in other grids, you can also order the notes in any random order using the Row Up
and Row Down buttons on the Tool Bar.
10. Go ahead and use the Row Up and Row Down buttons to change the order of the notes.
11. Close the Notes for Personal Category screen, saving your changes and stay in
Donald’s record.
12. Continue with the next tutorial.
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Tutorial 1.3 – Attaching a File
One of the more powerful features of the Notes screen is the ability to attach external files to
your notes. These external files become an integral part of the record. Attachments can be
added to any note. Let’s add a note and then add an attachment to it.
1. In the Screen dropdown, select Status and select the Category Notes button.
2. Enter a new note and stay on that note row.
3. Select the Attach button located to the right of the notes grid.
This option displays the Select File screen that is used to select a file. We have created a
simple Word doc that you can now attach to this note.
4. In the PT9\SAMPLES directory of your local People-Trak drive, select the
ATTACHMENT TIP.DOC file.
Internal processing for the attachment is performed. The Type column is updated with
DOC, indicating that a DOC type file is attached to that note.
In the Note Text field, you would typically want to add a short description of the file
attached so that you can readily identify the attachment without having to open it.
5. In the Note Text field, add the following to your existing note and do not press ENTER
so you stay on this note row:
This note contains an attachment that includes a valuable tip on attachments.
6. Continue with the next tutorial.

Notes, Attachments, and Document Management

21

Lesson 1

Tutorial 1.4 – Opening an Attachment
Once a file has been attached to a note, the file can be opened for viewing at any time.
1. Verify that the cursor is positioned to the note row containing the file you attached in the
last tutorial.
2. Select the Show button located to the right of the notes grid.
The software associated with the DOC extension, typically Microsoft Word, is fired up
and the attachment is loaded. This document is a copy of the original document and is
stored in the ATTACH file under the appropriate enterprise folder.
Note: The attached file is intended to be for display only. If the attached file needs to be
modified, do so outside of People-Trak. You will then need to delete the current
attachment from the note and attach the appropriate file.
3. Close the attachment after reading the tip.
If you attach a file from a software product that you use, another user can only activate
that attachment if the user also has that software product. For example, if you attach a
word processing file (as we just did) from your word processor and another user has a
different word processor, the other user might not be able to view the attachment. The
Attachments feature is a very powerful feature, but it must be used with appropriate
discretion. If your organization has standard word processors, spreadsheets, and other
software products, there will be no problem.
4. Continue with the next tutorial.
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Tutorial 1.5 – Deleting an Attachment
If a file has been attached to a note, you may need to delete it because it was attached in error
or you need to attach an updated file to the note. Let’s delete the attachment you added to the
note.
1. Verify that the cursor is still positioned to the note row containing the file you attached in
the last tutorial.
2. Select the Delete button located to the right of the notes grid
The Type column is cleared, showing that the attachment is now deleted from that note.
If you had another file to attach to this note, you could do so now.
3. Close the Notes for Status Category screen, without saving.
4. Close the employee record, without saving.
5. This concludes this tutorial and lesson.
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This lesson covers creating and viewing note attachment history and how to create triggers
based on dates within note details. It concludes by showing how to define search tags and
specify date details within an archived document.

Tutorials
Note Attachment History: demonstrates how to create and show attachment history within
Category Notes.
Revisiting an Attachment: shows how to create an alert trigger for an attachment using the
Revisit Date.
Defining Details for Archived Documents: demonstrates how to define search tag criteria
and expiration dates within archived documents.

Lesson 2

Tutorial 2.1 – Note Attachment History
In Data Entry training, we learned how to use the notes feature to keep track of notes and
important documents that had been attached to them.
Donald Stern was issued a company car in order to facilitate a carpool with his coworkers. To
be on the safe side, HR has requested a copy of his license to have on file.
Many times when photocopies are made, they get lost in the piles of paper on a desk or are
found crumpled in the back of a file cabinet. But why waste paper and file cabinet space
when we can just add an image as attachment into Donald’s notes? Let’s give it a try and take
a closer look at the attachment history and details features.
1. Open Donald Stern’s employee record.
2. On the Personal screen, select the Category Notes button to display the Notes for
Personal Category screen.
3. Insert a new note row.
4. In the Note Text field, enter the following:
Donald Stern drivers license image
All that’s left to do is attach the image that we want.
5. Select the Attach button.
The Select File screen is displayed.
6. In the PT9\SAMPLES directory of your local People-Trak drive, select the PETE.JPG
file.
7. Select the Save icon on the toolbar to save the latest change.
Whenever you open, delete, or add an attachment to a note, the action is added to the
History log. With our image attached, we can take a look at the history that has been
created so far.
8. Select the History button.
The History screen is displayed with an “Attached” history action. In addition, we can
also see the date, time and user who attached the file.
9. Close the History screen.
Before we move on, let’s take a look at Donald’s driver’s license.
10. Select the Show button.
Whoops! It seems we selected an image of our good friend Pete instead of Donald’s
driver’s license. We can fix this mistake by deleting the current attachment and then
attach the correct one.
11. Close the attachment and return to the Notes for Personal Category screen.
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12. Select the Delete button located to the right of the notes grid
With the image deleted, we can now attach the file we should have the first time around.
13. Select the Attach button.
The Select File screen is displayed.
14. In the PT9\SAMPLES directory of your local People-Trak drive, select the
DONALDSTERN_DL.JPG file.
15. Select the Save icon on the toolbar to save the latest change.
This time, the correct file has been attached. After making all these changes, let’s see
how our attachment history has been affected.
16. Select the History button.
Note that we have now added an opened, delete, and attached action to our attachment
history.
17. Close the History screen.
Viewing attachment history not only keeps track of actions performed to a note over
time, it can be beneficial in regards to note security. If you notice suspicious actions
being performed during non working hours, you may be identifying a potential security
threat.
18. Close the Notes for Personal Category screen and Donald’s employee record, saving
your changes.
19. Continue with the next tutorial.
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Tutorial 2.2 – Revisiting an Attachment
We have successfully added an attachment to Donald’s notes. Driver’s licenses aren’t valid
forever, so let’s utilize a few of the category note features to make sure Donald’s information
is kept up to date once his license expires.
1. Open Donald Stern’s employee record.
2. On the Personal screen, select the Category Notes button to display the Notes for
Personal Category screen.
3. Select the note that we created in the previous tutorial and select the Details button.
The Search Tag 1 and Search Tag 2 fields have been populated with Donald’s employee
ID and full name backwards, respectively. The rest of the fields have been left blank and
are used to set dates for when an attachment expires and needs to be deleted, or in our
case, when the attachment needs to be revisited and updated.
4. In the Revisit Date field, use the date popup to select a date that is exactly one week
from today’s date.
While we’re at it, let’s go ahead and alert Donald and the HR department before the note
reaches its revisit date.
5. Close all screens, save all your changes and return to the Organizer desktop.
6. On the Tools menu, select Alert Triggers.
7. On the File menu, select New Alert Trigger or on the Tool Bar, click the New Alert
Trigger button to start a new alert trigger.
8. Change the name of the trigger to Update Driver’s License Image.
9. Set the Category to Personal.
10. Leave the Active check box selected.
11. Click the Conditions tab.
12. In the If Today’s Date Is field, set the amount field to 7. Set the period type to Days.
Select the Before operator. Now, in the fourth field, select the Note Revisit Date field.
The condition should now read as follows:
If Today’s Date is

7 Days
Before
Note Revisit Date

Setting the alert a week before the revisit date will give both parties enough time to get
things ready.
13. Select the Active Records Only check box to limit this alert to active records only.
14. On the Actions tab, click the popup button to display a list of the available actions.
15. Add a Send Message action and go into the details for that action.
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16. In the User ID field, enter DEMO.
17. In the Message Text field, enter the following:
This employee must provide an updated drivers license for carpooling privileges to
continue. A scanned image must be received by the end of the week.
18. Close the Send Message screen, saving your changes.
19. Select the Send Email action and open the details.
20. In the To Address Type field, select Field Substitution.
21. In the To field, select Email, which is the email address field for the employee.
22. Click the Message tab.
23. In the From Address Type field, select Position.
24. In the From field, click the popup button and select 1043 - Human Resources Manager.
25. In the Subject field, enter Drivers License Update.
26. In the Text field, enter the following text:
Records indicate that your driver’s license is currently out of date. Please schedule
an appointment with the Human Resources before the end of the week. Failure to do
so will remove your driving privileges within the carpool.
27. Close the Alert Triggers screen, saving your changes.
28. Switch to the Safety Management module and then switch back to the Personnel
Management module.
Our trigger will be executed and you will see the email being sent out to Donald as well
as a message appearing in your inbox.
29. Open the Inbox, open the Message item, read it and then close the message and your
Inbox.
30. Continue with the next tutorial.
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Tutorial 2.3 – Defining Details for Archived Documents
In previous training, you learned how to archive a document for future reference by using the
output to archive feature. Within this lesson we will take a look at the additional fields that
we can use and details that can be defined once a document has been archived.
1. Open Julie Carrington’s record and view her Status screen.
2. Change her Hire Date to today’s date and save your change.
3. Repeat the same steps in Donald Stern and Gregory Wilson’s employee records, saving
your changes and then returning to the Organizer desktop.
Now that we have some data to work with, let’s create a report that we can archive.
4. Create a new Adhoc Report named New Hires for the Current Month.
5. Click the Report Definition tab and select the following three fields in the order shown:
Full Name
Hire Date
Source
6. Click the Query tab and enter the following query equation, as described below:
Hire Date

Between

START-OF-MONTH and END-OF-MONTH

7. We should see the employees that were hired between the start and end of the current
month.
8. Run the report.
9. On the Tool Bar, click the Output to Archive button.
The Output to Archive screen is displayed.
10. In the Document Name field, add today’s month and year to the end of the field.
11. Change the Category to Status
12. In the Description field, enter the following text:
This report includes the new hire sources for: name of current month and year.
As you can see, the Search and Retention frame contains fields that we have seen before
in Category Notes. Since our archived document was not created in an open record, the
search tag fields are blank. It is up to us to define some meaningful search criteria.
13. In the Search Tag 1 field, enter the name of the current month and year.
14. In the Search Tag 2 field, enter: Recruiting
15. In the Expiration Date field, use the date popup to select the first of next month.
16. Close the Ouput to Archive screen, saving your changes.
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17. Close the Document Viewer and the Adhoc Reports screen.
18. From the Explorer, run the Absences by Account report.
19. On the Tool Bar, click the Output to Archive button.
20. In the Search Tag 1 field, enter the name of the current month and year.
21. In the Search Tag 2 field, enter: Attendance.
22. In the Expiration Date field, use the date popup to select yesterday’s date.
23. Close the Ouput to Archive screen, saving your changes.
24. Close the Document Viewer and the Adhoc Reports screen.
25. Run the Absences by Department report.
26. On the Tool Bar, click the Output to Archive button.
27. In the Search Tag 1 field, enter the name of the current month and year.
28. In the Search Tag 2 field, enter: Attendance.
29. In the Expiration Date field, use the date popup to select yesterday’s date.
30. Close all screens, saving your changes and return to the Organizer desktop.
31. This concludes this tutorial and lesson.
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This lesson covers how to create a document from scratch within Document Management and
how to use search tag criteria within the lookup feature. It concludes by showing how to
create alert triggers to assist with document maintenance.

Tutorials
Creating a Document from Scratch: shows how to create and define specifications for a
document within the Document Management module.
Document Lookup Using Search Tags: demonstrates how to utilize pre defined search tags
when using the lookup feature in Document Management.
Managing Documents with Triggers: shows how to create a trigger to alert a user once
documents have expired

Lesson 3

Tutorial 3.1 – Creating a Document from Scratch
The Document Module provides you with an enhanced ability to track and define documents
that have been attached via Archived Documents or Category Notes. In addition, documents
may be created in this module independent from the archive document or notes features. This
is especially helpful when it comes to managing documents such as union handbooks, vendor
or client agreements, or as we will see in our upcoming tutorial, your annual maintenance
agreement.
1. Switch to the Document Management module.
2. On the Shortcut Bar, click the New Document button to create a new document.
The Create Document screen is displayed with the Document Source field set to Scratch.
We will leave this field as is.
The Module Name field has been defaulted to Document Management. Since this
document is originating in the Document Management module, we will leave this field
alone as well.
3. Click Create.
Let’s take a look at the ID and Name frame first.
The Document ID is automatically assigned and the Document Type and Module Name
have been defaulted to Document and Document Management respectively.
4. In the Document Name field, assign our document the name Annual Maintenance
Agreement.
The next few fields will look familiar to you. Just as we did when we created a note and
archived documents, we are able to define search tags for this new document.
5. In the Search Tag 1 field, enter the following text: Technical Difference
6. In the Search Tag 2 field, enter the following text: People-Trak
7. In the Search Tag 3 field, enter the following text: Contract
8. In the Search Tag 4 field, enter the following text: Maintenance
9. In the Document Category field, use the popup to assign the document to the Document
category.
The Document Creator has been assigned to the DEMO user and the Document Date to
the current date.
10. In the Document Text field, enter the following description:
Attached is the Annual Maintenance agreement from Technical Difference, Inc for
our People-Trak HR software.
We have gone ahead and saved you extra work by scanning a maintenance agreement and
converting it to a PDF file. With those details squared away, we can continue by
attaching the file to our document.
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11. Select the Attach button.
The Select File screen is displayed.
12. In the PT9\SAMPLES directory of your local People-Trak drive, select the ANNUAL
MAINTENANCE AGREEMENT.PDF file.
Internal processing for the attachment is performed. The Type column is updated with
PDF, indicating that a PDF type file is attached to that note.
In the Document Text field, you would typically want to add a short description of the
file attached so that you can readily identify the attachment without having to open it.
13. Select the Show button to take a look at our attachment.
14. Close the attachment and return to the Document screen.
Let’s take a look at the history we have created for this new document.
15. Select the History button.
The History screen is displayed with our recently performed “Attached” and “Opened”
actions.
16. Close the History screen.
Now that our document has been attached, let’s assign it an expiration date.
17. Select the Details button.
For our maintenance agreement, let’s say that we want to set a document expiration date
2 months before maintenance actually expired. With the date around 33 months in the
future, we can start counting on our fingers and toes to figure out when that would be. Or
we could let People-Trak do the calculation for us.
18. In the Retention Months field, enter 33.
The Expiration Date field is automatically updated to reflect the date exactly 33 months
from today’s date. If we wanted to set an alert trigger to remind us in the future, we
would simply use the Expiration Date field. It’s as easy as that!
19. Close the Details screen saving your changes.
20. Close the Annual Maintenance Agreement document, saving your changes.
21. Continue with the next tutorial.
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Tutorial 3.2 – Document Lookup Using Search Tags
Within the Document Management module, you have the ability to search across modules
using one of the appropriate search tag fields. Remember the search tags we defined in the
previous lessons? We are going to see those tags in action within the lookup feature.
1. Use the Open Document shortcut to start the Lookup process.
Note that the order of the lookup fields on the Basic tab is Document ID, Document
Name, Search Tag 1, and Search Tag 2. We don’t yet know the document names or ID’s
for all of our stored documents, so let’s change our lookup fields to each of the search
tags.
2. Click Cancel to close the Lookup Document screen.
3. On the Setup menu, select Module Setup.
4. Click the button adjacent to Lookup Field 1 to display a list of the fields. Select the
Search Tag 1 field.
5. Change the second field to the Search Tag 2.
6. Change the third field to the Search Tag 3.
7. Change the fourth field to the Search Tag 4.
8. Close the Module Setup screen, saving your changes.
9. Use the Open Document feature to start the Lookup process.
Now our lookup for Document Management is based solely on our search tag criteria.
We want to find a few of our documents that we recently created. To start, let’s narrow
down the search by the date that we defined for the Search Tag 1 field.
10. In the Search Tag 1 field, enter the name of the current month and year.
11. Click Search.
Since they were all assigned the same Search Tag 1 field, all three of our archived
documents are returned to the search results.
But say we just wanted to see the documents for which we set the Search Tag 2 field to
Attendance.
12. Click Clear to clear the search results and fields.
13. In the Search Tag 2 field, enter Attendance.
14. Click Search.
This time, the lookup results return the two documents we were looking for.
15. Select OK to open the record group.
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The Document screen is displayed for our first document. Let’s take a quick tour of all
the information that has been stored for this archived document.
As you can see, the Document Name has been populated with the name we gave our
archive document. The Document Type is Archived Document and the Module Name has
been set to Personnel Management, the module we created this document in. All these
fields are display only and cannot be changed.
Note that the Search Tag 1 and Search Tag 2 fields are set to the criteria we set. We can
change these tags or define additional ones, but we will leave our document as is for now.
Within the Document frame, we are able to change the Document Category and
Document Text but again, let’s keep things the way they are.
16. On the Toolbar, select the Next Record button to move to our next archived document.
Once again, the fields on this screen have been stored according to the type of document
and what we defined when we output to archive. Why don’t we go ahead and find the
note we created earlier and see how it has been stored differently within Document
Management?
17. On the Toolbar select Open Document to start the lookup.
18. In the Search Tag 1 field, enter 1006.
Because it was the only document assigned to that search tag, the note document for
Donald Stern is opened and the main Document screen is displayed.
Since this document originated from a note that we created, all fields are display only,
except for the Document Name, Document Text and search tags 3 and 4. We won’t be
adding any search tags, but there are a few fields that we will change.
The Document Name has been defaulted to New Document, which does not give us any
idea as to what this document is for. Let’s assign it a new name.
19. In the Document Name field, enter: Drivers License- Donald Stern
20. In the Document Text field, replace the existing text with the following:
A scanned image of Donald’s driver’s license has been attached.
21. Close the Document Management module, saving your changes.
With document lookup knowledge under our belts, let’s return our lookup fields to their
original settings.
22. On the Setup menu, select Module Setup.
23. Click the button adjacent to Lookup Field 1 to display a list of the fields. Select the
Document ID field.
24. Change the second field to the Description.
25. Change the third field to the Search Tag 1.
26. Change the fourth field to the Search Tag 2.
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27. Close the Module Setup screen, saving your changes.
28. Continue with the next tutorial.
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Tutorial 3.3 – Managing Documents with Triggers
In previous lessons, we set expiration dates for many of the documents that we created.
Typically, we could run a report every so often to inform us as to which documents are out of
date. However, by using the Expiration Date field within an alert trigger, we can be alerted
once documents are out of date and need to be deleted or updated.
1. On the Tools menu, select Alert Triggers.
2. On the File menu, select New Alert Trigger or on the Tool Bar, click the New Alert
Trigger button to start a new alert trigger.
3. Change the name of the trigger to Expired Documents Alert.
4. Leave the Active check box selected.
5. Click the Conditions tab.
Just in case the documents are needed on their expiration date, we are going to set the
alert to go off the day after they expire.
6. In the If Today’s Date Is field, set the amount field to 1. Set the period type to Days.
Select the After operator. Now, in the fourth field, select the Document Expiration Date
field. The condition should now read as follows:
If Today’s Date is

1 Days
After
Document Expiration Date

7. Select the Active Records Only check box to limit this alert to active records only.
8. On the Actions tab, click the popup button to display a list of the available actions.
9. Add a Send Message action and go into the details for that action.
10. In the User ID field, enter DEMO.
11. In the Message Text field, enter the following:
This document has expired and is no longer valid. Please make sure that this
document is deleted from Document Management today.
12. Close the Send Message screen, saving your changes.
13. Close the Alert Triggers screen, saving your changes.
14. Switch to the Generic module and then switch back to the Document Management
module.
Our trigger will be executed and you will see a message appearing in your inbox for each
expired document. In our case, you should see two.
15. Open the Inbox, open the Message items, read them, and close the messages and your
Inbox.
Let’s take those messages seriously and delete our expired documents!
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16. Use the Open Document shortcut to start the Lookup process.
17. In the Search Tag 2 field, enter Attendance.
The two expired documents are returned to the results.
18. Select OK to open the record group.
19. For the first expired document, select Delete Document from the File menu to delete it.
Repeat the same steps to delete the second expired document.
20. Close all screens, saving your changes and return to the Organizer desktop.
21. Exit People-Trak.
22. This concludes this tutorial and lesson.
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